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FCC Information

Note: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy, and if not installed
and used in accordance with the instruction manual, may cause interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

� Reorient or relocate the receiving antenna;

� Increase the separation between the equipment and receiver;

� Connect the equipment into an outlet on a circuit different from that which the
receiver is connected;

� Consult the dealer or an experienced radio/television technician for help.

© Copyright 2005 ALTUSEN® PAPE-0252-1AXG
All brand names and trademarks are the registered property of their respective owners.
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Package Contents

Standard Components

The standard IP9001 package consists of:

� 1 IP9001 Card

� 1 USB Cable

� 1 Custom Made Feature Connector Cable

� 1 Power Cord

� 1 AC Adapter

� 1 Software CD

� 1 User Manual

� 1 Quick start guide

� 1 Warranty registration card

Optional Components

The following components do not come with your IP9001 card. You must order these

components separately.

� internal modem daughterboard

� internal battery backup with battery clip 

Note: The optional modem is NOT designed for Console Redirection. While it is

possible to do Console Redirection with it, the performance is extremely slow

and debilitating to system operations.

Check to make sure that all of the components are present and in good order. If

anything is missing, or was damaged in shipping, contact your dealer.

Read this manual thoroughly and follow the installation and operation procedures

carefully to prevent any damage to the switch or to any other devices on the IP9001

installation.
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Conventions

This manual uses the following conventions:

Courier Indicates text that you should key in.

[ ] Indicates keys you should press. For example, [Enter] means
to press the Enter key. If keys need to be chorded, they
appear together in the same bracket with a plus sign between
them: [Ctrl+Alt].

1. Numbered lists represent procedures with sequential steps.

� Bullet lists provide information

> Indicates selecting an option on a menu. For example, Start >
Run means to open the Start menu, and then select Run.

Indicates critical information.

Getting Help

For additional help, advice, and information, ALTUSEN provides several support

options. If you need to contact ALTUSEN technical support with a problem, please

have the following information ready beforehand:

� Product model number, serial number, and date of purchase.

� Your computer configuration, including operating system, revision level,
expansion cards, and software.

� Any error messages displayed at the time the error occurred.

� The sequence of operations that led up to the error.

� Any other information you feel may be of help.
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ALTUSEN Technical Support

North America Technical
Phone Support

Registered ALTUSEN product owners are entitled
to telephone technical support. Call the ALTUSEN
Technical Support Center: 949-453-8885.

International Technical
Phone Support

1. Contact your local dealer.
2. Call the ALTUSEN Technical Support Center:

(886-2) 8692-6959.

Email Support Email your questions and concerns to:
support@altusen.com

Online Troubleshooting The ALTUSEN support website:
http://www.altusen.com/support

provides online troubeshooting that describes the
most commonly encountered problems and offers
possible solutions to them.

Online Documentation User Manuals are available electronically at the
ALTUSEN support website:

http://www.altusen.com/support

Software Updates Download the latest drivers and firmware for your
product from the  ALTUSEN support website:

http://www.altusen.com/support

Product Information

For information about all of ALTUSEN’s products and how they can help you

connect without limits, visit ALTUSEN on the web.

ALTUSEN Authorized Resellers

ALTUSEN provides the following ways to find an authorized reseller in your area:

� In the United States of America, call: 866-ALTUSEN (258-8736)

� In Canada and South America, call: 949-453-8885

� In all other locations, call: 886-2-8692-6789

� Visit ALTUSEN on the web at http://www.altusen.com for a list of locations and
telephone numbers

2005-06-09

ix



Notes:

2005-06-09

x



Chapter 1.

Introduction

Features

Feature Description

Key Feature � 100% out-of-band 
� 100% operating system independent

Soft Processor � plugs into a mission critical server 
� half-sized PCI form factor plugs into any PCI slot

Remote Client � industry standard Internet browser (any JavaScript 1.2 
capable) 

� manage the server from anywhere in the world 
� SSL v3 for secure connection

Processor System
On Chip (SOC)

�  32-Bit 266 MHz ~ 400 MIPS MMU 
� 16 K I-cache 
� 16 K D-cache

Memory � 32 megabyte PC-133 MHz SDRAM standard (soldered on 
PCB, you cannot upgrade or remove)

Flash � 16 bit, 16 megabyte flash ROM (soldered on PCB, you 
cannot upgrade or remove)

Ethernet LAN � integrated SOC 10/100 MAC 
� external level one 10/100 BASE-TX Ethernet 

On-Board Modem
+ DAA (Optional)

� 56K socket modem (not designed to support Console 
Redirection)

I2C Controller
Hardware Monitor
(OEM version
feature)

� ambient temperature monitoring
�  PCI voltage monitoring
� card internal voltage monitoring
� battery voltage monitoring
� RTC
� external RTC for time stamp of events

Power Supply � switching logic between optional 6 V wall adapter, 5 V PCI, 
3.3 V PCI, and optional on-board battery

Battery Backup
(Optional)

� 900 mAh LION battery provides 30 minutes of battery backup 
in case of host system or optional wall adapter power failure

Form Factor � half-size standard PCI card
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Feature Description

Environmental
Specifications

� storage temperature: -20 degrees to 80 degrees C
� relative humidity: 5 to 80 percent non-condensing @ 

40 degrees
� operating temperature: 0 to 45 degrees C
� vibration: 2.5G acceleration over 2000 Hz sine wave, 

2oct/mian sine sweep
� shock: 20G; 11 msec duration, half-sine shock sweep

Monitoring � IPMI 1.5 compliant (OEM version feature)
� I2C sensors (OEM version feature)
� SDR and Soft Processor (SP) file support for easy 

customization (OEM version feature)
� OEM specific

Communication � 10/100 megabit Ethernet LAN
� 56K modem (optional); not designed to support console redirection
� TCP/IP
� DHCP enabled
� SNMP
� web based interface

USB Device
Controller for
Mouse/Keyboard

� USB 1.1 device controller

USB Device
Controller for
CD-ROM

� USB 2.0 device controller

USB Device
Controller for FDD

� USB 1.1 device controller

USB Hub � USB 2.0 hub

Serial Ports X 3 � debug port
� RS485
� one external

Debug Support � Jtag ICE

Alert Notification � SNMP trap up to eight destinations
� numeric and alphanumeric paging (when optional modem is 

installed)
� email notification

Console
Redirection

� via 10/100 megabit Ethernet LAN
� up to three multiple redirection sessions
� up to 15 screens per second high speed redirection 

hardware engine
� no overhead on the host system, complete operating sytem 

independence
� redirect BIOS screens and setup screens
� seamless text and graphics transition
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Feature Description

Security �  SSL (Secured Socket Layer) 3.0 (Pass-phrase encrypted 
certificates are not supported)

�  DAA (Digestive Authentication Access)
�  MD-5

Virtual Boot �  USB 2.0 CD-ROM
�  USB floppy
�  supports boot to image
�  allows remote operating system boot up and installation

Note: For information on how to create a bootable CD, visit
nero.com or roxio.com. You can do a search on how to create
a bootable CD using their products. You can also consult your
CD writer’s documentation.

Host Side
Operating System
Support

�  Windows 2000/2003/XP and above
�  RedHat 8.0 and above

OEM
Development Kit
Platform
Management
Configuration
Program (PMCP)

available
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Notes:
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Chapter 2.

Installation

Before you Begin

Avoid Electro-Static Discharge (ESD)

Electrostatic discharge (ESD) can damage the IP9001 card and other

system components. Keep your IP9001 card in its antistatic bag until it is

ready to be installed. Avoid contact with any component or connector on

any adapter card, printed circuit board, or memory module. Handle these

components by the mounting bracket.

Perform all unpacking and installation procedures on a ground connected

antistatic mat. Wear an antistatic wristband grounded at the same point as

the antistatic mat. You can also use a sheet of conductive aluminum foil

grounded through a one megaohm resistor instead of the antistatic mat.

Similarly, a strip of conductive aluminum foil wrapped around the wrist

and grounded through a one megaohm resistor serves the same purpose as

a wristband.
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Installation Overview

Installation of the IP9001 card takes the following steps:

Step Action

1 Unpack the IP9001 card (and check jumper settings)

2 Install the optional battery and battery clip

3 Install the optional modem daughterboard

4 Plug the IP9001 card into the host system and attach internal cables

5 Connect external cables

6 Confirm the motherboard’s BIOS settings

7 Install the operating system and IP9001 card’s drivers

8 Install all IP9001 Windows Software Components

9 Setup your client system’s Internet browser 

10 Connect to the IP9001 from a client system

11 Load the IP9001 SDR and Soft Processor (SP) File for your
motherboard or server board model (OEM version feature)

The following sections describe how to perform these steps.
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1. Unpack the IP9001 card (and check jumper settings)

Card Layout Diagram

MAC Address

Each IP9001 card has a unique MAC address. The MAC address is the only way to

distinguish one IP9001 card from another when you run programs such as Remote

Recovery Application (RRA) and RacTrendsSeek Locator. For reference, you can

write your IP9001 card’s MAC address in the table below or in Appendix H, MAC

Address Map. Use the first line in the table as an example.

MAC Address Location Description

00-40-D9-02-9B-3C Server Room, Rack 3-4 RH 9.0, Mail Server

 

IP9001
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Check the Jumpers

Check that the card’s jumpers match the description in the following table:

Jumper Setting

JP4 Pins 1 and 2: Open

JP5 Pins 1 and 2: Open

JP6 Pins 1 and 2: Open

JP7 Pins 1 and 2: Open

JP8 Pins 1 and 2: Open

JP11 Pins 1 and 2: Shorted

JP12 Pins 1, 2, and 3: Open

JP13 If your host system’s motherboard supports 12C on the PCI slots,
Short pins 1 and 2. If not, see that pins 1 and 2 are Open.

JP14 If your host system’s motherboard supports 12C on the PCI slots,
Short pins 1 and 2. If not, see that pins 1 and 2 are Open.

JP4 and JP5 - Chassis/Motherboard Power Switch:

Verify that there is no jumper on JP4 and JP5. These two headers are to be used with

a cable, not a jumper.

JP6 - IP9001 Reset Button:

You can temporarily short this jumper to reset your IP9001 card. For normal

operations, verify that there is no jumper on JP6.

Pin Description

1 Ground

2 Reset #
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JP7 and JP8 - Chassis/Motherboard Reset Switch:

Verify that there is no jumper on JP7 and JP8. These two headers are to be used with

a cable, not a jumper.

JP11 - Flash Write Enable/Disable:

You can write-protect your IP9001 card’s firmware so that it cannot be flashed. By

default, pins one and two are shorted so that you can flash the firmware.

Pin Description

1 VCC3

2 Write protect enable

3 Ground

Pin Description

1-2 Flash write enable

2-3 Flash write disable
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JP12 - Recovery Mode:

This jumper is primarily used to recover a failed flash attempt. By shorting pins two

and three, you can place your IP9001 card into Recovery Mode. See Appendix C,

Remote Recovery Application (RRA) for more information on how to recover your

IP9001 card. By default, pins one, two and three are open.

Pin Description

1 NA

2 Ground

3 GP I/O PA10

JP13 and JP14 - PCI Bus SMB Data and Clock Jumper:

These two headers allow your IP9001 card to read I2C bus information. If your hosts

system’s motherboard has support for I2C on the PCI slots, place a jumper on these

two headers. By default they are open.  

Note: 1. Most PCI slots have a “floating” I2C bus. A floating I2C bus means that

there is no physical connection between the two I2C pins on the PCI slot

and the motherboard’s I2C bus. Shorting JP13 and JP14 would be useless

in this case.

2. JP13 and JP14 can be used in place of the IP9001 Feature Cable to gather

I2C bus information from the motherboard.

3. Only the OEM version can utilize the hardware health monitoring

capabilities of the IP9001 card. The hardware health monitoring function

requires an OEM specific cable and Sensor Definition Kit (SDK/SDR) file,

and a Soft Processor (SP) file.
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2. Install the Optional Battery and Battery Clip

The IP9001 on-board battery backup is an optional component. When the optional

battery is installed, your IP9001 card can stay powered on for 30 minutes without any

external power from the host system or AC adapter.

BBU (Battery Backup Unit) Installation

To install the Battery Backup Unit, refer to the diagram below and do the following:

1. Plug the battery cable into the Battery connector (J2).

2. Place the battery pack in between the three mounting holes.

3. Align and snap the plastic battery clip into the three mounting holes over the

battery pack.
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Charging the Battery Pack

The optional battery pack is shipped uncharged. The IP9001 card automatically starts

to charge the battery after you install it. You must charge the battery pack before it

can be used to provide backup power to the IP9001 card. The minimum time that the

battery must be charged is six hours. To order extra batteries, contact your dealer.

Part No. Description Weight

BAT-LIION-3.6-01 Battery, Li-Ion, 3.6 V, 855/900 mAh on-board
battery pack with mounting brackets

33 g

If you keep a stock of extra IP9001 batteries, store them at room temperature.

Note: 1. Li-Ion has no memory effect. Lithium-ion cells offer extended cycle life

when cycled at low depth of discharge. 

2. The recoverable capacity of cells stored for over one year at room

temperature and fully charged is 94%. The retained capacity of these same

cells is 87%. This means the self-discharge rate for a fully charged cell is

approximately 150 mAh per year or 427 uAh per day. The self-discharge

rate for cells is non-linear. A partially charged cell has a self-discharge rate

of about 80 uAh per day.

Warning: Risk of explosion if battery type used is incorrect. ONLY use

battery part number BAT-LIION-3.6-01.
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Changing the Battery Pack 

The optional IP9001 battery pack must be replaced every 400 cycles. Cells retain 80%

of their original capacity after 400 cycles. A cycle is defined as a full charge (4.2V)

followed by a full discharge (2.8V). Keep in mind that cycling or storing the cells at

elevated temperatures can reduce the cell capacity and cycle life. Cells discharged and

stored at low temperatures can extend the shelf life of the batteries.

To replace the battery pack:

1. Bring down the operating system properly. Turn the computer power off. Remove

the computer cover. Remove the IP9001 card.

2. Disconnect the battery pack cable from jumper J2. Remove the plastic battery clip

and then replace the Battery Backup Unit.

3. Install a new battery pack and connect the new battery pack to  jumper J2. Align

and snap the plastic battery clip into the three mounting holes over the battery

pack.

4. Reinstall the IP9001 card in the host system.

Battery Disposal

The material in the battery pack contains heavy metals that can contaminate the

environment. Many jurisdictions have laws that prohibit the disposal of some

rechargeable batteries in public landfills. These batteries must be sent to a specific

location for proper disposal.

You must comply with all applicable battery disposal and hazardous material

handling laws and regulations in the country or other jurisdiction where you are using

an optional battery pack on the IP9001 card.

Warning: Do not dispose of the IP9001 optional battery pack by fire. Do not

mutilate the battery pack. Do not damage it in any way. Toxic chemicals can

be released if it is damaged. Do not short-circuit the battery pack.
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3. Install the Optional Modem Daughterboard

The IP9001 modem daughterboard is an optional component. Locate JP10 on the

IP9001 card. It has a series of pinholes that allow you to insert the modem

daughterboard. Match the modem daughterboard and the pin holes so that the pins

align properly. Insert the modem daughterboard by sliding it straight down into the

IP9001 card. See Appendix F: Modem Daughterboard for more information.

Note: 1. The optional modem is NOT designed for Console Redirection. Although you

can still perform Console Redirection, it is debilitating and extremely slow.

4. Plug the IP9001 Card into the Host System and

Attach Internal Cables

Plug the IP9001 into any available PCI slot on the host system and attach the internal

cables as described in the following sections.

J3 - Service Connector

This jumper is used exclusively to service the IP9001 card. J3 is not described in this

document.

J4 - JTAG ICE Connector

The JTAG (Joint Test Action Group ICE (In-Circuit Emulator) header is used to

debug and service the IP9001 card. J4 is not described in this document.
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J5 - IPMB (Intelligent Platform Management Bus)

If your motherboard has an IPMB connector, you can connect a cable from J5 on the

IP9001 card to the IPMB connector on your motherboard. The pin description is

shown in the table below:

Pin Description

1 Positive Signal

2 Ground

3 Negative Signal

IPMB (Intelligent Platform Management Bus) 

The IPMI specification was developed by Intel, Dell, Hewlett-Packard, and NEC to

provide a standard interface to be used for monitoring server items such as

temperature, voltage, fans, power supplies, and chassis. IPMI is comprised of three

specifications Intelligent Platform Management Interface (IPMI), Intelligent Platform

Management Bus (IPMB) and Intelligent Chassis Management Bus (ICMB). The

IPMI specification defines the interface between management software and chassis

management hardware. The IPMB specification defines the internal Intelligent

Platform Management Bus. The ICMB specification defines an external bus for

connecting additional IPMI enabled systems. 

The electrical interconnect for system management is based on the inter-IC (I2C) bus.

This bus is a two wire serial interface (clock, data) driven by open-collector drivers.

Devices arbitrate for the bus based on a collision detection mechanism. The I2C data

and I2C clock signals are referred to as an IPMB. 

The IPMB connector can be used to read IPMI information from the motherboard’s

System Management Controller. The format and definition of the IPMI information

must be based on the IPMI v1.5 Specification. 

The IPMI specification was architected around the server motherboard environment.

In a typical motherboard, the Management Controller connects to a variety of dumb

sensors located on the motherboard and within the chassis. The command set contains

commands tailored to this environment and are intended to handle sensors, data

repositories, event logs and watchdog timers.
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J9 - IP9001 Feature Connector

This feature connector is primarily used for operating the host system’s motherboard

power and reset switch. It can also be used to gather I2C bus information from the

motherboard.. The pin description is shown in the table below:

Pin Description Pin Description

1 Not Connected 11 Reset_Host #

2 I2C Clock 12 Ground

3 Not Connected 13 Ground

4 Not Connected 14 Not Connected

5 Power_Off # 15 Not Connected

6 I2C Data 16 Ground

7 Not Connected 17 Not Connected

8 Not Connected 18 Not Connected

9 Not Connected 19 Not Connected

10 Not Connected 20 Ground

Note: 1. JP13 and JP14 can be used in place of the IP9001 Feature Cable to gather

I2C bus information from the motherboard.

2. JP4 and JP5 can be used in place of the IP9001 Feature Cable to power on,

power off, and power cycle the motherboard.

3. JP7 and JP8 can be used in place of the IP9001 Feature Cable to reset the

motherboard.

4. Only the OEM version can utilize the hardware health monitoring

capabilities of IP9001 card. The hardware health monitoring function

requires an OEM specific cable and Sensor Definition Kit (SDK/SDR) file,

and Soft Processor (SP) file.

5. IPMI support is an OEM version feature. 

6. This cable must be custom made for your specific configuration.
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JP2 - Serial Port Connector 

You can connect an external 9 pin serial port connector to this header. This header is

primarily used to text redirect over the serial port.

JP3 - Service Connector 

This jumper is used exclusively for servicing the IP9001 card. JP3 is not described in

this document.

JP4 and JP5 - Chassis/Motherboard Power Switch

JP4 and JP5 can be used in place of the IP9001 Feature Cable to power on, power off,

and power cycle the motherboard. 

Connect a two pin cable from the motherboard’s Power (Soft On/Off) header to JP4

on your IP9001 card. Connect the chassis power switch to JP5 on your IP9001 card.

JP6 - IP9001 Reset Button 

You can short this jumper to reset your IP9001 card.

Pin Description

1 Ground

2 Reset #

JP7 and JP8 - Chassis/Motherboard Reset Switch 

JP7 and JP8 can be used in place of the IP9001 Feature Cable to reset the

motherboard. 

Connect a two pin cable from the motherboard’s reset header to JP7 on your IP9001

card. Connect the chassis reset switch to JP8 on your IP9001 card.

Note: JP7 and JP8 can be used instead of the IP9001 Feature Cable to reset the

motherboard.
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5. Connect External Cables

1. Connect the USB cable from the back of the IP9001 card to the motherboard’s

USB port.

2. Connect your VGA monitor to your IP9001 card.

3. Connect the RJ45 LAN cable from your local network to your IP9001 card.

4. Connect your phone cord from the back of the IP9001 card to the telephone wall

outlet. (Only if the optional modem daughterboard is installed.)

5. Connect your AC adapter.

6. Confirm the Motherboard’s BIOS Settings 

1. Power on the motherboard and enter the BIOS.

2. Use the following table to confirm that your motherboard’s BIOS settings are

correct.

BIOS Section Setting

Boot Options> Removable Devices Virtual Floppy or USB Boot Device

Boot Options> ATAPI CDROM Virtual CDROM or USB Boot Device

Advanced> PCIPnP>
Configuration> Legacy USB Support

Enable

3. Save the BIOS settings and restart the computer.

Note: 1. Make sure that your motherboard BIOS supports Legacy USB devices,

USB Boot or Boot to USB. 

2. On some motherboards and server boards, depress the <CTRL>, <ALT>,

and <ESC> keys simultaneously to enter the BIOS. On others use the <F2>

keys. See your server’s documentation for more information on entering

the BIOS setup.
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7. Install the Operating System and IP9001 Drivers

1. Install the operating system (if applicable) on the host system.

2. (Windows 2000/2003/XP only) When prompted for the Virtual Floppy drivers,

install the IP9001 card’s Virtual Floppy drivers located in the INF folder on the

IP9001 CD.

3. (Windows 2000/2003/XP only) When prompted for the virtual CD-ROM drivers,

install the Windows default CD-ROM drivers.

Note: Do not use virtfl.inf when prompted to install the virtual CD-ROM

drivers. The Virtual CD-ROM device does not require any special drivers.

You can select the default option Microsoft Windows provides.

Installing Virtual Floppy Drivers on Microsoft® Windows

Microsoft® Windows 2000/2003/XP operating systems need an .INF file to handle

Virtual Floppy device provided by the IP9001 card. 

Note: The .INF installation procedure only needs to be done once on the host

system. Once the Virtual Floppy is properly loaded, you can perform floppy

redirection without going through any extra steps.
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The first time you run windows after installing the card, the Found New Hardware

Wizard comes up:

1. Select Install from a specific location, then click Next.

2. Select the virtfl.inf  file, located in the INF directory on the IP9001 CD. If

prompted with the Windows Logo dialog box, click Continue Anyway.

Note: Do NOT use the default file that the Microsoft® Windows operating system

presents when it is searching for the Virtual Floppy driver. Ensure that the

Microsoft® Windows operating system is asking for the the virtual floppy driver on

the IP9001 CD before allowing the installation of the .INF file to continue.
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As the Hardware Update Wizard loads the virtual floppy driver from the IP9001

CD, the installation progress status is displayed.

3. Once the file is loaded, click Finish to complete the installation. (Windows may

require a reboot of the host system after the installation of the virtual floppy driver.)

4. Check in the Device Manager to be sure the driver was properly installed.
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8. Install the Windows Software Components

The Windows Software Components comprise a collection of host-side and remote

access programs. Their functions are briefly explained in the following table:

Program Description

ConfigApp Allows you to configure the IP9001 card either from the host
system or from a client system.

WinCuri A command prompt-based program to configure the IP9001
card. It allows you all the functionality of both the Internet
browser-based Remote Access Companion for the IP9001,
and the ConfigApp program.

HostHeartbeat HostHeartbeat is installed as a service in Windows. It tells
whether or not the operating system on the host system is
functioning. It can also detect whether the operating system
was shutdown normally or not.

Floppy Image
Creator

Used to create bootable floppy image files that you can use
to boot the IP9001 card from.

Remote Recovery
Application (RRA)

A recovery tool that can be executed from a remote client
system located on the same network as the IP9001 card.
You can use it to recover a failed flash attempt.

Note: 1. You must physically set the IP9001 card you want 
to recover into Recovery Mode by shorting pins 2 
and 3 of jumper JP12.

2. The IP9001 card must be write enabled before you 
can flash an image to it. Shorting pins 1 and 2 on 
jumper JP11 write enables the card.

3. Since the firmware upgrade process is a critical 
operation, make sure that the chances of a power or 
connectivity loss are minimal when performing this 
operation.

RacTrendsSeek
Locator
(RM Seek)

In order to completely configure your IP9001 card, you must
access it from another system on the same network by
means of its IP address. If you have installed the IP9001 on
a network that uses DHCP, you can search the network for
the IP9001 card. To locate and find out its IP address, you
can use RacTrendsSeek Locator.
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To install the Windows Software Components, do the following:

1. Insert the IP9001 CD into the host system (the one with the IP9001 card); and

navigate to the CDROM\ServerAgents\Win32 folder; and double click Setup.exe.

The Installshield Wizard comes up.

2. When the confirmation window comes up, click Next, to move on:

3. If the Customer Information dialog box comes up, enter your name and the name

of your organization in the appropriate fields.

4. When the Setup Type window opens, select Complete, then click Next:
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5. When the Install Program window opens, click Install:

6. When the installation is complete, click Finish to complete the procedure:

7. Repeat steps 1 - 6 for any local network computers you wish to use to access the

host system.
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9. Setup Your Client Internet Browser

Before you can redirect the host system’s console or view the Crash screen, you must

first set up your Internet browser on the client system. To do so, follow the steps,

below:

1. Open your Internet Explorer browser. From the menu, select Tools, then select

Internet Options:

2. When the Intenet Options window opens, click Settings:
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3. In the Settings window, select Every visit to the page or Automatically; then click

OK to apply the change and to go back to the Internet Options dialog box:

Note: Other settings can cause old data to be displayed when performing

operations on the IP9001.

4. To setup Internet Explorer to allow downloading and running of signed ActiveX

controls, in the Internet Options dialog box, select the Security tab; then click

Custom Level:

Note: The default security setting for Microsoft Windows 2003 servers is High.

This disables many components necessary for the IP9001 GUI. Therefore,

you should set the security settings for a remote client running Windows

2003 server to Medium, or Low.
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5. In the Security Settings dialog box, in the Download signed ActiveX controls

section select Enable:

6. Scroll down to the Run ActiveX controls and plug-ins section. Select Enable; then

click OK:
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7. When the Warning! dialog box comes up, click Yes to accept the changes and go

back to the Internet Options dialog.

8. Click Apply, then click OK to complete the changes:

Note: 1. You must restart Internet Explorer before the changes take effect.

2. Remote Console cannot run with any other security settings in Internet

Explorer.
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10. Connecting From a Client System

In order to connect to the IP9001 card, you must access the IP9001 from another

system on the same network (referred to in this manual as the client system). To do

this, you must know the IP9001 card’s IP address. If you have installed the card on a

network that uses DHCP, you can search the network for the IP9001 card. To locate

and find out its IP address, you must run RacTrendsSeek Locator. 

Note: 1. To get or set the IP address on the IP9001 card in a Windows

2003/2000/XP environment, you can also run the ConfigApp program on

the host system. See Appendix B, ConfigApp for more information on how

to use this program. 

2. Make sure that you have already installed the IP9001 Windows Software

Components on the system that you want to use to locate the IP9001 card. 

To connect to the IP9001 from a remote client system, do the following:

1. Run the RacTrendsSeek Locator program entry on your remote client system:
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2. When the opening screen comes up, click Next:

3. When the Add IP Address Range dialog box comes up, key in a name for your

network in the Network Name field, and the range of IP addresses that the card’s

IP address will fall under, then click Add:
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4. In the dialog that comes up, the name and IP range of the IP9001 card appears in

the list at the right. Place a check in the box next to the range of IP addresses, then

click Next:

5. The Selected IP Range dialog comes up with the name and IP range of the IP9001

card displayed. Click Next to continue:
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6. If the IP range is correct, RacTrendsSeek Locator will locate the IP9001 card, and

list it with all the IP9001 cards it has discovered:

Note: If more than one IP9001 card is found, you can distinguish them by the

IP9001 card’s name. The IP9001 card’s name consists of the characters IP

followed by the MAC address of the card’s NIC.

7. In this example, the IP9001 card’s IP address is 192.168.0.10. Double click the IP

address to start managing the IP9001 card and write down its IP address. After

RacTrendsSeek Locator discovers all the IP9001 cards, Click Finish.
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8. The login screen comes up:

The default User Name is root; the default password is superuser (both in lower case).

Note: When you log in using this user name and password, you have full

administrative privelegess. For security purposes, we strongly advise you

to change the root password. See Administrator Setup under the IP9001

Configurations section of this chapter.
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11. Load the SDR and Soft Processor (SP) File

This is an optional procedure and requires a custom file specific to your motherboard.

To load the SDR and Soft Processor (SP) file, do the following:

1. Select Configure from the menu bar at the top of the IP9001 GUI, then select

PMCP Health Configuration from the menu:

2. The Host Health Monitoring Files dialog box opens. Click Browse:
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3. Starting from the IP9001 CD, browse to the folder that contains your SDR file.

Note: You can create your own SDR and Soft Processor (SP) Files using the

Platform Management Configuration Program (PMCP).

4. Select the SDR file (it will end in -sdr.bin), then click Open:

5. In the dialog box that comes up, click Upload:

6. The next dialog box confirms that the the SDR file was successfully uploaded, and

prompts you to upload a Soft Processor Instruction Set file. Click Browse to continue.

7. In the dialog that comes up, select the SP file (it will end in -sp.bin), then click

Open:

8. In the dialog box that comes up, click Upload:

9. The next dialog box confirms that the the SP file was successfully uploaded, and Host

Health monitoring is active:

Click Close to end the installation procedure.
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Notes:
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Chapter 3.

Locating the IP9001 Card

Overview

IP9001 cards can be accessed from anywhere on your Intranet via an Internet

browser, allowing you to maintain your critical servers from a physically remote

location. This chapter explains how to locate the IP9001 card on your local network.

Locating the IP9001 Card

In order to connect to the IP9001 card, you must access it from another system

(referred to as the client system) on the same network. To do this, you must know the

IP9001 card’s IP address. If you have installed the IP9001 on a network that uses

DHCP, you can ascertain its IP address with the RacTrendsSeek Locator program.

Note: 1. In a Windows 2000/XP environment, you can also get or set the IP9001’s IP

address by running the ConfigApp program on the host system. See Appendix

B, ConfigApp, for more information on how to use the program.

2. Make sure that you have already installed the IP9001 Windows Software

Components on the system that you want to use to locate the IP9001 card.

To connect to the IP9001 from a remote client system, do the following:

1. Run the RacTrendsSeek Locator program:
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2. When the opening screen comes up, click Next:

3. When the Add IP Address Range dialog box comes up, key in a unique name for

your network in the Network Name field, then key in the range of IP addresses that

the card’s IP address will fall under, in the Start IP Address and End IP address

fields, then click Add:

Note: If you only wish to scan for one card with a specific address, the Start and

End addresses should be the same.
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4. In the dialog that comes up, the name and IP range of the IP9001 card appears in

the list at the right. Place a check in the box next to the range of IP addresses, then

click Next:

5. The Selected IP Range dialog comes up with the name and IP range of the IP9001

card displayed. Click Next to continue:
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6. If the IP range is correct, RacTrendsSeek Locator will locate the IP9001 card, and

list it with all the IP9001 cards it has discovered:

Note: If more than one IP9001 card is found, you can distinguish them by the

IP9001 card’s name. The card’s name consists of the characters IP

followed by the MAC address of the card’s NIC.

7. In this example, the IP9001 card’s IP address is 192.168.0.10. Double click the IP

address to start managing the IP9001 card and write down its IP address. After

RacTrendsSeek Locator discovers all the IP9001 cards, Click Finish.

Usage

Once the program has been installed and setup, you can access it any time by double

clicking its icon on the task bar:

The screen that was active when the program was last viewed will appear.
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Chapter 4.

Browser Operation

Overview

The IP9001’s user-friendly Graphics User Interface (GUI) is accessed with a standard

Internet browser. Specify the IP9001’s IP address in your browser’s Locator bar, and

you can be up and running in a matter of minutes. This chapter describes the browser

screen layout, and explains how to use each of the IP9001’s features and functions.

Note: 1. If you don’t know the IP9001’s IP address, get it from your administrator.

2. Some elements of the GUI may have changed since this manual was

written. If the GUI on your monitor does not match the ones in this

document, go to our website to download the most current version.

Logging In

Before you are granted access to the IP9001 web page, a login page comes up asking

you to provide a User Name and Password:

Provide a valid Username and Password, then Click OK to continue.

Note: 1. If you are the administrator logging in for first time, use the default User

Name: root; and the default Password: superuser. Use lower case for both.

2. This login gives you full administrative powers. For security purposes, we

strongly recommend you change the root password to something unique.
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After you have successfully logged in, the IP9001 Main Screen appears:

� The Menu Bar at the top of the screen consists of three items:Manage, Configure,
and View. Clicking a menu item causes a drop down list of submenu choices. The
meanings and use of these coices are explained in the chapters that follow.

� Below the menu bar, are four Quick Launch icons. These icons are a short cut
method to access their equivalent functions found in the menu bar submenus.

� The Session Information entry at the right of the screen shows the User Name and
permission level of the currently logged in user.
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Chapter 5.

The Manage Menu

Overview

When you click Manage on the menu bar, its submenu drops down:

A brief description of the items is given in the table below:

Item Description

Remote Console Starts a remote console session with the host system.

Remote Power Control Powers On, Powers Off, Power Cycles or Resets the
host system.

Upgrade Firmware Upgrades the IP9001’s firmware.

Reset Card Resets the IP9001 card.

Each entry is explained in detail in the sections that follow
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Remote Console

The Remote Console submenu offers three choices for remote console display as

shown in the figure and table below:

Item Description

High Color Quality (16-bit)
for fast/LAN Connection

Allows the IP9001 to send 16 bits per pixel color.
Recommended for faster connection speeds or over a
LAN connection.

Fast Network/LAN
connection

(Low Color Quality)

Allows the IP9001 to send 8 bits per pixel color.
Recommended for lower connection speeds or over a
WAN connection.

When using this connection, you can opt not to use
software compression. Compression can increase the
frame rates. It is best used for slower connections.

Slow Network/WAN/DSL
Connection

(Low Color Quality)

Allows the IP9001 to send 8 bits per pixel color.
Recommended for lower connection speeds or over a
WAN connection.

When using this connection, you can also use software
compression. Compression can increase the frame rates.
It is best used for slower connections, such as DSL.

Note: The Low Color Quality (8-bit) for slow/WAN/DSL Connection mode is

recommended for low speed connections such as those over a Wide Area

Network or home DSL. If you are connecting over a LAN at high speeds you

can use High Color Quality (16-bit) for fast/LAN Connection mode. In order

to change modes you must stop redirection, close the browser, and reconnect

in the appropriate mode.
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Console Redirection

The most powerful feature of the IP9001 is the ability to redirect the host system’s

console - giving you the ability to manage your host system as if you were actually

right in front of it.

Internet Explorer Setup

Before you can perform redirection, you must first set up Internet Explorer. This is

the same procedure that was described in Chapter 2, pages 25 to 28. If you haven’t

already set IE up according to the steps described, refer back to that section to set up

your browser now.

Note: The Remote Console program cannot run, and console redirection cannot take

place, unless Internet Explore is set up according to the steps indicated.

Starting Redirection

To begin Console Redirection, do the following:

1. From the Manage menu, select Remote Console, then the quality mode you wish

to use:

The Loading Remote Console screen appears:
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2. When the authentication dialog box comes up, key in your Username and

Password; select a data transmission speed; then click Login:

The Console Redirection screen opens:

Now that you have redirected the host system’s console, you have the ability to

manage the host system from your console just as if you were physically at it.

3. Drop down the Keyboard menu, and click the Alt+Ctrl+Del entry to begin.

The next sections explain how to use the console redirection screen.
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The Console Redirection Screen

Several drop down menus to manage the host system are arranged across the screen.

The next sections describe the functions of each of the menu items.

The Console Redirection menu:

Item Function

Start Console Redirection Begins console redirection

Stop Console Redirection Ends console redirection

Restart When console redirection is active, it stops redirection,
then restarts it.

Full Screen Toggles viewing console redirection in Full Screen
mode On or Off.

Note: Set the client system screen resolution to 1024 x
768 in order to view the host system in true full screen
mode.

Sync Cursor Syncs or unsyncs the host and client mouse pointers.

CDROM Redirection Toggles the redirection of the CDROM drive On or Off.

Floppy Redirection Toggles the redirection of the floppy drive On or Off.

Note: This feature is not available on all versions of the
IP9001.

Note: These functions can also be performed with hotkey combinations. See p. 71

for details.
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The Keyboard Menu:

Under console redirection some keystrokes cannot be captured and sent to the host

system - the items on this menu provide the keystroke functionality to the host system.

Item Function

Hold Right Ctrl Key Acts as the Right Ctrl key*

Hold Right Alt Key Acts as the Right Alt key*

Hold Left Ctrl Key Acts as the Left Ctrl key*

Hold Left Alt Key Acts as the Left Alt key*

Left Windows Key Acts as the Left Windows key

Right Windows Key Acts as the Right Windows key

Alt+Ctrl+Del Acts as the Ctrl-Alt-Del combination*

Auto Key-Break Mode This menu item must be enabled when USB keyboard
emulation is used. The IP9001 does not use USB
keyboard emulation. Instead, the IP9001 uses legacy
PS/2 emulation. This feature is used to avoid repeated
keystrokes over slow connections.

Encryption Click this item to enable/disable encryption of the
keyboard data being transferred from the remote client.

* This function can also be performed with a hotkey combinations. See p. 71 for

details.
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The View Menu:

This View menu contains one item: Toolbar. Clicking Toolbar brings up the Console

Redirection toobar. The Console Redirection toolbar is discussed in detail on p. 50.

The Macros Menu:

Record New Macro allows you to record a set of keystrokes. A good example of how

this would be useful is when the IP9001 is used in conjunction with a KVM switch.

Normally, you must use a key sequence to switch systems. With a pre-recorded macro

created for that purpose, you could switch systems by runnning the macro instead of

having to input the sequence manually.

The Help Menu:

This menu contains the About RConsoleOCX Control item. Click it to view the

RConsoleOCX Control version number and copyright information.
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The Console Redirection Toolbar

Clicking Toolbar on the View menu brings up the Console Redirection toolbar:

The toolbar allows you to perform console redirection functions more conveniently

when you are in full screen mode and the menus are not visible. It is especially useful

if you are not familiar with the hotkey combinations.

Clicking the arrow at the right of the toolbar displays Console Redirection Status

information:

The meanings of the fields are given in the table below:

Field Function

Compression Indicates whether or not you are using compression.

Resolution Indicates the resolution quality.

Frame Rate Indicates the current fram rate.

Active Clients Shows how many users are currently logged into the IP9001.
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Toolbar Icons

The function that each of the toolbar icons performs is described in the table below:

Icon Description

Toggles Console Redirection On and Off.

Toggles mouse synchronization On and Off.

Toggles full screen mode On and Off.

Note: Set your client’s resolution to 1024 x 768 to see the host system
in true full screen mode.

Toggles the Ctrl key On and Off. The icon on the left of the CAD
button represents the Left Ctrl key; the icon on the right of the CAD
button represents the Right Ctrl key.

Toggles the Alt key On and Off. The icon on the left of the CAD button
represents the Left Alt key; the icon on the right of the CAD button
represents the Right Alt key.

Performs a Ctrl+Alt+Del (CAD) operation.

Toggles CDROM device redirection On and Off.

Toggles floppy device redirection On and Off

Note: Floppy device redirection is not available on all versions of the
IP9001 card.

Toggles the Power Control dialog box On and Off. Remote power
control is discussed in detail on p. 63.
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CD Drive Redirection

Starting CD drive redirection:

To perform CD drive redirection, do the following:

1. Use one of the following three methods to invoke the redirection:

� Click the CD Drive Redirection icon on the Redirection Toolbar (see p. 51)

� Select CDROM Redirection on the Console Redirection menu (see p. 47)

� Use the Alt+E hotkey combination (see p. 71)

Note: You must be logged in as an administrator on the windows client to

perform CD-ROM drive redirection.

2. In the dialog box that comes up, select whether you want to redirect the CD-ROM

drive or a CD image file, then click OK.

3. In the dialog box that comes up, select the CDROM drive you want to redirect,

then click OK. CDROM drive redirection begins immediately.
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Stopping CD drive redirection:

To stop CD drive redirection, use one of the following three methods:

� Click the CD Drive Redirection icon on the Redirection Toolbar (see p. 51)

� Select CDROM Redirection on the Console Redirection menu (see p. 47)

� Use the Alt+E hotkey combination (see p. 71)

A dialog box comes up to inform you of the progress:

When the dialog box closes, redirection has ended.
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Floppy Drive Redirection

Starting floppy drive redirection:

To perform floppy drive redirection, do the following:

1. Use one of the following three methods to invoke the redirection:

� Click the Floppy Drive Redirection icon on the Redirection Toolbar (see p. 51)

� Select Floppy Redirection on the Console Redirection menu (see p. 47)

� Use the Alt+P hotkey combination (see p. 71)

Note: You must be logged in as an administrator on the windows client to

perform floppy drive redirection.

2. In the dialog box that comes up, select whether you want to redirect the floppy

drive or a floppy image file, then click OK.

3. In the dialog box that comes up, select the floppy drive you want to redirect, then

click OK. Floppy drive redirection begins immediately.
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Stopping floppy drive redirection:

To stop floppy drive redirection, use one of the following three methods:

� Click theFloppy Drive Redirection icon on the Redirection Toolbar (see p. 51)

� Select Floppy Redirection on the Console Redirection menu (see p. 47)

� Use the Alt+P hotkey combination (see p. 71)

A dialog box comes up to inform you of the progress:

When the dialog box closes, redirection has ended.
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Floppy Image Creation

Using a floppy image file during device redirection is faster and more efficient than

redirecting from an actual floppy disk. It is also more convenient to have a series of

floppy images stored on a CD or on a local or networked hard disk drive than to keep

and maintain actual floppy disks.

To create a floppy image file, do the following:

1. Install the IP9001 utility programs (located on the Software CD that came with

your IP9001 package) on your system.

2. Run the Floppy Image Creator program:

3. In the dialog box that comes up, select Create an Image file from a Floppy Media,

then click Next.
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4. In the dialog box that comes up:

a. Select the floppy drive that you want to create the floppy image from

b. Select a location where you want the image to be stored and give it a file name

c. Put the floppy with the data you want to copy to the image file in the floppy

drive

d. Click Start

A progress dialog box comes up to indicate the status of the procedure:
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5. Once the image file is successfully created a confirmation dialog box comes up.

Click OK to move on.

6. When the Create Image file from a Floppy Media dialog box comes back up, click

Exit to close the program.

This completes the floppy image file creation procedure. You can now use this image

file during device redirection.
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Transfer A Floppy Image To Floppy Disk

To transfer a floppy image to floppy disk, do the following:

1. Run the Floppy Image Creator program:

2. In the dialog box that comes up, select Transfer the Image from a file to a Floppy

Media, then click Next.
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3. In the dialog box that comes up, click Browse.

4. Navigate to the image file you want to transfer to the floppy disk, then click Open.
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5. In the dialog box that appears, click Start.

A progress dialog box comes up to indicate the status of the procedure:

6. Once the image file is successfully created a dialog box comes up to indicate so.

Click OK to move on.
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7. When the Load Image file to a Floppy Media dialog box comes back up, click

Exit to close the program.

This completes the floppy image file transfer to floppy media procedure.

Stopping Console Redirection

To stop console redirection, use one of the following three methods:

� Click the Stop Redirection icon on the Redirection Toolbar (see p. 51)

� Select Stop Console Redirection on the Console Redirection menu (see p. 47)

� Use the Alt+T hotkey combination (see p. 71)

A dialog box comes up to inform you of the progress:

When the dialog box closes, redirection has ended.
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Remote Power Control

The second item on the Manage menu is Remote Power Control:

The Power Control dialog box allows you to remotely reset, power off, power on, and

power cycle the host system:

Simply click the icon to perform the corresponding action on the remote system. The

entry below the icons indicates the remote system’s current power status (Off or On).
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Upgrade Firmware

The Upgrade Firmware utility provides an easy, convenient method to upgrade the

IP9001’s firmware:

To begin, click the Upgrade Firmware entry on the Manage menu to bring up the

opening dialog box:

Note: 1. Upgrading the firmware is a critical procedure. Make sure that the chances

of a power or connectivity loss are minimal when performing this operation.

2. If you click Cancel at this time to abort the upgrade process, the IP9001

card resets itself.

3. If you cancel after you have entered Upgrade Mode, the IP9001 card must

be reset by closing the Internet browser and then logging back onto the

IP9001 in a new browser session.
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To update the IP9001’s firmware, do the following:

1. Click Enter Firmeare Upgrade Mode. The following dialog box appears:

2. In the dialog box tha comes up, click Browse to navigate to where the firmware

upgrade file (*.IMA) resides:

When the IP9001 is in Upgrade Mode and you want to abort the procedure,

you must use the Cancel button to close the upgrade dialog boxes. DO NOT

use the Title Bar’s X button to close the dialog boxes.
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3. Select the image file (it has an ima extension), then click Open.

4. In the dialog box that comes up, click Upload.
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5. The upgrade utility starts the upload of the new firmware file and checks it for

integrity. After it verifies the image file, it displays the following message:

Click OK to move on.

6. A dialog box comparing the old and new versions appears:

� To upgrade some components but not others, check the component you want
to upgrade in the Selection column.

� To upgrade all the components, check Complete Flash.

� To upgrade, but retain a copy of your original configuration, check Preserve
Configuration.

When your selections have been made, click Next to move on.

Note: If you choose to cancel the upgrade, the IP9001 card must be reset by

closing the Internet browser and then logging back onto the IP9001 in a

new browser session.
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7. A confirmation dialog box comes up. Click OK to start the actual upgrade.

8. A screen showing the upgrade progress comes up. After the procedure has

successfully completed the following screen appears:

You must now close your browser and log back onto the IP9001 in a new browser

session.
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Reset the IP9001

The function of this menu item is to reset the IP9001:

1. When you click Resert Card on the Manage menu, a confirmation dialog box

comes up. Click OK to reset the card:
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2. When the reset procedure is complete, the following dialog box appears.:

Close your browser and relog into the IP9001 in a new browser session.
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Remote Console Hotkey Combinations

The following table lists hotkey combinations that perform many of the remote

console functions directly from the keyboard.

Hotkey Function

ALT + S Start Console Redirection

ALT + T Stop Console Redirection

ALT + R Restart Console Redirection

ALT + F Toggle Full Screen Mode

ALT + M Synchronize Mouse

ALT + A Hold/Release Right Alt Key

ALT + B Hold/Release Left Alt Key

ALT + L Hold/Release Right Ctrl Key

ALT + N Hold/Release left Ctrl Key

ALT + D Generate Ctrl + Alt + Del

ALT + E Start CDROM Drive Redirection

ALT + P Start Floppy Drive Redirection
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Notes:
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Chapter 6.

The Configure Menu

Overview

When you click Configure on the menu bar, its submenu drops down:

Item Function

Users Administer users that can access the IP9001 and host system.

Network Configure the IP9001’s network parameters.

Firewall Control which IP addresses can access the IP9001.

Alert Notification Configure how alerts are sent.

Date & Time Configure the IP9001’s date and time settings.

Serial Port Configure the IP9001’s Serial Over LAN access.

SSL Certificate Upload a Digital Certificate and Private Key to the IP9001 card.
Note: Pass-phrase encrypted certificates are not supported.

PMCP File Upload Upload a platform management file for your
motherboard/server board.

IPMI Configuration Configure the IP9001 card to read data from an onboard
baseboard management controller (BMC) on the
motherboard/server board.

Server OS Monitoring
& Recovery

Configure operating system monitoring and recovery
methods.

PPP Configuration Set the PPP addresses for the Server and Client when
using a modem.
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Users

Clicking Users on the Configure menu brings up the User setup dialog box:

The dialog box screeen elements are described in the table below.

Element Function

Username User’s log in name.

Note: The default administrator’s Username is root; the default
administrator’s password is superuser. For security purposes,
we strongly recommend that you change the default password
to something unique.

Description Descriptive information about the user.

Add Click to add a new user account.

Remove Click to delete the user account currently selected in the
Username list.

Properties Click to View/Edit the user account currently selected in the
Username list.

Close Click to exit the User Administation dialog box.
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Adding Users

To add a user account, do the following:

1. In the User dialog box, click Add. The Add a New User dialog box appears:

2. Key the appropriate information into the Username, Description, Password and

Confirm Password fields. Please note the following:

� User names are case sensitive. They can consist of any combination of
alphanumeric characters but they must start with an alphabetic character, and
must be between 4 and 12 characters long.

� Entering a remark in the Description field is optional.

� Passwords are case sensitive. They must be between 8 and 16 characters long.
For security purposes, we recommend using a combination of alphabetic and
numeric characters.

� Confirm the password by entering it again in the Confirm Password field.

3. Assign the user’s permissions and allowed interfaces:

� Only users with Administrator permissions are allowed to add, edit, and
remove users. Non-administrator users can only change their own password.

� Users with Administrator permissions are automatically granted access to all
interfaces.
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Removing Users

To delete a user account, do the following:

1. Select the account to be removed from the User Name list.

2. Click Remove.

3. In the confirmation dialog box that comes up, click OK to confirm the deletion, or

click Cancel to abort the procedure.

2005-06-09

76



Viewing and Editing Users

To view and/or edit a user account, do the following:

1. Select the account from the User Name list.

2. Click Properties.

The Modify User dialog box comes up. This dialog box is similar to the Add a

New User dialog box on p. 75. Refer back to the field descriptions given there, if

necessary.

3. After you have made your changes, click OK to complete the procedure, or click

Cancel to abort the procedure without saving your changes.
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Network

Clicking Network on the Configure menu brings up the Network Configuration dialog

box:

� The IP9001’s MAC address displays in the MAC Address field.

� If you want the IP9001 to get its IP address dynamically (from a DHCP server),
select Obtain IP address automatically.

� If you want to assign a static IP address to the IP9001, select Use the following IP
address settings, then fill in the IP address, Subnet mask, and Gateway fields with
entries that are appropriate for your network.

When you have finished making your entries, click Apply to save your changes. To

abort the procedure without saving your changes, click Close.

Note: If you change the information in the Network Configuration dialog box, you

are prompted to close your browser and reconnect to the IP9001 at its new IP

address.
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Firewall

Clicking Firewall on the Configure menu brings up the Firewall Settings dialog box:

This dialog box allows you to configure the IP9001’s access parameters, by entering

IP addresses and ports to block or allow.

� Click the Blocked Sites tab to enter a range of addresses that you want to block.

� Click the Trusted Sites tab to enter a range of addresses that you want to always
allow.
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After you click Add for either the Blocked or Trusted site, the Add a Rule dialog box

comes up:

Note: The dialog box shown is for Blocked sites. The dialog box for Trusted sites

has the same fields, so the descriptions that follow also apply to the dialog for

Trusted sites.

Field Function

Start IP Address This field allows you to enter the start IP address of the subnet
you want to block or always allow.

Subnet Mask This field allows you to enter the specific subnet of the IP
address range that you want to filter.

Protocol This drop down list lets you select a protocol (UDP or TCP)
that the IP9001 will either accept or ignore.

All Ports If this is enabled, the IP9001 will accept or ignore data on all
ports (1 through 65535).

Port Range If this is enabled, you can select a specific range of ports that
you want the IP9001 to accept of ignore.

Starting Port This field allows you to enter the the first port of the range that
you want the IP9001 to accept or ignore.

Ending Port This field allows you to enter the last port of the range that you
want the IP9001 to accept or ignore.

[OK] Click OK when you are satisfied with the information you
entered.

[Cancel] Click Cancel to discard your changes and exit.
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Alert Notification

Clicking Alert Notification on the Configure menu brings up the Alert Notification

dialog box:

This dialog box lets you configure where and how various alerts from the IP9001 are

sent.
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Date & Time

Clicking Date & Time on the Configure menu brings up the Date & Time dialog box:

Use this dialog box to set the IP9001’s date and time. You can set the time manually,

synchronize it with your local machine; or have it synchronized with an NTP

(Network Time Protocol) server.
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Serial Port

Clicking Serial Port on the Configure menu brings up the Serial Port dialog box:

Use this dialog box to set the serial port parameters: baud rate, data bits, parity, stop

bits, and flow control.
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SSL Certificate

Clicking SSL Certificate on the Configure menu brings up the SSL Certificate dialog

box:

Use this dialog box to upload an SSL Certificate and SSL Private Key for verification

when users access the IP9001 with their browsers.

Click the Browse button to navigate to where your Certificate and Private Key files

are located - both files have a PEM file extension.

Note: The IP9001 does not support pass-phrase encrypted certificates.

After both files are uploaded a dialog comes up reminding you that the IP9001 needs

to be reset for the new certificates to take effect. Click OK to reset the card.

Now, users can securely access the IP9001 with a format similar to the following:

https://[the IP9001’s IP address]

2005-06-09

84



PMCP File Upload

Clicking PMCP Health Configuration on the Configure menu brings up the The Host

Health Monitoring Files dialog box.

This is the same dialog box, and involves the same procedures discussed in Chapter 2,

p. 34, under Load the SDR and Soft Processor (SP) File.

Follow the steps on those pages to complete this procedure.
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IPMI Configuration

Clicking IPMI Configuration on the Configure menu brings up the IPMI

Configuration dialog box:

To read data from an onboard baseboard management controller (BMC) on the

motherboard/server board, put a check in the the checkbox, then click Apply.
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Server OS Monitoring and Recovery

Clicking Server OS Monitoring and Recovery on the Configure menu brings up the

Server OS Monitoring and Recovery dialog box:

This dialog box allows you to configure operating system monitoring and recovery

methods.
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PPP Configuration

Clicking PPP Configuration on the Configure menu brings up the PPP Configuration

dialog box:

This dialog box allows you to set the PPP addresses for the Server and Client when

using a modem.
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Chapter 7.

The View Menu

Overview

When you click View on the menu bar, its submenu drops down:

A brief description of the items is given in the table below: Each item is explained in

detail in the sections that follow.

Item Function

Card Health Shows health information for the IP9001.

Event Log Allows you to view and clear the event logs.

Server Health Shows the host system’s health information based on the
sensor readings and platform management configuration
information.

General Information Shows general information about the IP9001.

Last Saved Crash
Screen

Shows the last text screen on the host system before it
locked up.
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Card Health

Clicking Card Health on the View menu brings up a screen that shows the IP9001’s

health information:

Event Log

Clicking Event Log on the View menu brings up a screen that  allows you to view and

clear the event logs:
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Server Health

Clicking Server Health on the View menu brings up a screen that shows the host

system’s health information based on the sensor readings and platform management

configuration information:
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General Information

Clicking General Information on the View menu brings up a screen that provides

information about the IP9001:

The General Information screen has three tabs: Versions; Features; and Detailed

Versions.

Versions

When the General Information screen comes up, the Versions screen is the one that is

displayed. The meanings of the parameters and their values are explained in the table below:

Parameter Value

Firmware Version Shows the IP9001’s firmware version number.

Firmware Build Date Shows the IP9001’s firmware build date in MONTH
DAY YEAR format.

Firmware Build Time Shows the IP9001’s firmware build time in
HOUR:MIN:SEC format.

Firmware Description Shows a short description of the firmware.

Floppy Firmware Version Shows the floppy emulation firmware version.
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Features

The Features screen shows the available featuers provided by the IP9001:

The meanings of the parameters and their values are explained in the table below:

Parameter Value

Virtual Floppy Shows whether or not floppy redirection is available.

Virtual CDROM Shows whether or not CDROM redirection is available.

Virtual Keyboard/Mouse Shows the type of emulaton being used for the
keyboard and mouse.

KVM over IP Support Shows whether or not KVM over IP is available.
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Detailed Versions

The Detailed Versions screen shows the version numbers of the individual

components that make up the IP9001’s firmware:

The firmware components are listed in the Parameter column; the firmware version

of each component is listed beside it in the Value column.
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Last Saved Crash Screen

The Last Saved Crash Screen on the View menu allows you to see the last text-based

screen on the host system prior to its locking up or freezing during a blue screen. This

is useful because it allows you to troubleshoot the host system.

Clicking this item brings up a login screen. Provide your Username and Password,

then click Login to see the Crash Screen.

Note: 1. You must have the Java Runtime Environment (JRE) installed to view the

Crash Screen. If it isn’t already installed on your sysem, it is available for

free download from Sun’s Java site: http://java.sun.com

2. The maximum size of the Crash Screen image is 50 Kb. Therefore, only

one Crash Screen image can be saved, and only text-based crashes can be

saved. The output from a crash on a graphics based system would be too

large.

3. A captured Crash Screen image cannot be flushed from the IP9001’s

memory. It is automatically erased and replaced when the next Crash

Screen image is saved.
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Appendix A.

Feature Cable Layout

The IP9001 Feature Cable’s layout is illustrated on the next page.

Please make note of the following:

� If you do not have an American Megatrends Olympus II (series 821) motherboard, you
cannot use the I2C connector to monitor the hardware health of the motherboard.

� If you do not use the chassis power on switch or chassis reset switch pins, you
should place a plastic cap on them so that they do not short your motherboard. Do
not use a standard jumper. It will short the connection.
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1

3

5

7

9

11

15

17

2

4

6

8

10

12

16

18

20

I2C Clock

Ground

I2C Data

Ground

Ground

Power Off #

Reset #

Motherboard
I2C
Connector

Motherboard 
Power On
Jumper

Chassis
Power On

Switch

Motherboard 
Reset

Jumper

Chassis
Reset
Switch

Berg Electronics
Discrete 
Crimp-to-Wire 
FCI Part Number
Plastic Housing
Polarizing (Center) Key
65846-006
Tin-Lead Receptacles
47747-000

Berg Electronics
Discrete 
Crimp-to-Wire 
FCI Part Number
Latch Housing
65039-035
Tin-Lead Receptacles
47747-000

Molex (Bottom View)
SPOX(tm) Connector
IDT Spring Box
Molex Part Number
22-44-6031

Berg Electronics
Discrete 
Crimp-to-Wire 
FCI Part Number
Latch Housing
65039-035
Tin-Lead Pins
75653-005

Berg Electronics
Discrete 
Crimp-to-Wire 
FCI Part Number
Latch Housing
65039-035
Tin-Lead Receptacles
47747-000

Berg Electronics
Discrete 
Crimp-to-Wire 
FCI Part Number
Latch Housing
65039-035
Tin-Lead Pins
75653-005

All Wires Must Be 28 AWG, A Total Length of 15" Long and  Twisted Together

PART NUMBER CBL-G2RAC821
All Connectors Must be Labeled
Chassis Power On Switch = "Power"
Motherboard Power On Jumper = "Power"
Chassis Reset Switch = "Reset"
Motherboard Reset Jumper = "Reset"
Motherboard I2C Connector = No Label
Where two cables come together (marked with the letter       ), cables can be 
crimped with a connector or spliced and soldered. In Either case, the cable 
must be wrapped in non-conducting plastic.

Gray

Gray

Green

Yellow

Black (Ground)

Black (Ground)

Black

Black (Ground)

Black (Ground)

Blue

Blue

A

A

A

A

A

This cable is specifically 
designed for use with the 
American Megatrends 
Olympus II (series 821) 
motherboard only.

Pin Cap

Pin Cap

Berg Electronics
Discrete 
Crimp-to-Wire 
FCI Part Number
Latch Housing
65039-035
Tin-Lead Receptacles
47747-000
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Appendix B.

API Configuration Program

Overview

In addition to the usual browser based configuration, the IP9001 can also be

configured through an API utility, which is a GUI program that runs under Microsoft

Windows.

The utility can be run either from the host system, or from a client system. The client

system is the one that connects to the IP9001 remotely, over the network. This is

basically WinCuri with a GUI.

Setup

To start the API configuration program do the following:

1. On the CD that came with this package, go to either the

CDROM\RemoteTools\Win32\ directory, or the CDROM\ServerAgent\Win32\

directory and double click ConfigApp. The Choose Connection Type dialog box

comes up:
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2. If you are running the ConfigApp program from the host system, select I am on

the server which has an IP9001 plugged in; click OK.

Note: Make sure that the IP9001 card is connected to the host system’s

motherboard through the USB cable.

If you are running the ConfigApp program from a remote system, select I want to

connect to an IP9001 card on the network; key in the card’s IP address, your

username and password; then click OK.

After clicking OK in step 2, the Configuration dialog box appears with the User

Manager tab selected:

The Configuration dialog allows you to manage users, configure the network, flash

the IP9001 card’s firmware and perform advanced configuration operations.
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Configuration

The User Manager

This dialog box allows you to add, remove, and modify users.

Adding a User:

To add a user, do the following:

1. Click Add. The following dialog box appears:
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2. Fill in the fields according to the information provided in the table, below:

Field Description

User Name The name that the new user will log in with. The name
cannot be longer than eight characters.

Description A short note to describe this account (optional).

Password The password that the new user will log in with.

� Passwords must be a minimum of eight characters and
cannot be longer than 16 characters. We recommend
using alphanumeric passwords for better security.

� Passwords are case sensitive.

� Parenthesis, slashes, asterisks, spaces, the at sign (@),
and the hash sign (#) are not allowed.

Confirm
Password

Reenter the user’s password to confirm you entered it
correctly.

Permissions Choose the permissions for this user.

3. When you have finished, click OK to save your changes. To exit without saving

any changes, click Cancel.

Removing Users:

To remove a user, select the user in the Username list, then click Remove.
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Modifying User Accounts:

To modify a user’s account, do the following

1. Select the user in the Username list, then click Properties. The Properties dialog

box comes up:
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2. Fill in the fields according to the information provided in the table, below:

Field Description

User Name The user’s name appears here. This field is disabled, and
cannot be edited.

Description A short note to describe this account (optional). You can
edit the information if you so choose.

Password After enabling Change Password, this field becomes active.
You can change the user’s password according to the
following information:

� The new password must be a minimum of eight
characters and cannot be longer than 16 characters. We
recommend using alphanumeric passwords for better
security.

� Passwords are case sensitive.

� Parenthesis, slashes, asterisks, spaces, the at sign (@),
and the hash sign (#) are not allowed.

Confirm
Password

Reenter the new password to confirm you entered it
correctly.

Permissions Choose the permissions for this user.

3. When you have finished, click OK to save your changes. To exit without saving

any changes, click Cancel.
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Network Configuration

The Network Configuration tab allows you to change the way the IP9001 card

connects to the network.

By default, the IP9001 card obtains an IP address dynamically via DHCP. You can

change this to assign a fixed IP address to the card as follows:

1. Enable Use the following IP address.

2. Specify IP address, network mask, and gateway for the card in the appropriate

fields.

3. Click Apply to save your changes.

2005-06-09

105



Advanced Configuration

The Advanced dialog box allows you to force your IP9001 card’s on board NIC to a

specific MAC address:

1. Key the new MAC address into the New MAC Address field.

2. Click Apply.

3. To reset the card, click Reset the card now.
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Appendix C.

Remote Recovery Application

Overview

The Remote Recovery Application (RRA) is a recovery tool that can be executed

from a remote client system, running under Windows, located on the same network as

the IP9001 card. It is used to recover from a failed flash attempt.

Note: 1. You must physically set the IP9001 card you want to recover into Recovery

Mode. To do this, short pins 2 and 3 of jumper JP12 on the card.

2. The IP9001 must be write enabled before you can flash an image to it. To

write enable the card, short pins 1 and 2 of jumper JP11.

3. Upgrading the firmware is a crucial operation. Make sure that the chances

of a power or connectivity loss are minimal when performing this

procedure.

To run the IP9001 RRA, navigate to the directory where the RRA program is located

(IP9001CD → Recovery Tools → Win32) and double click the RRA icon. The

following screen appears:
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After a few moments it displays the Active Devices in Recovery Mode that it has

found:

The meaning of the screen’s buttons are explained in the table, below:

Button Purpose

Listing Stop Click to stop searching the network for active cards in
Recovery Mode.

Refresh Click to restart searching the network for active cards in
Recovery Mode.

Selection Select After you select a card from the list, click this button to
proceed with the Flash Recovery operation for it.

Cancel Click to cancel any new settings that have not been
saved.
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Flashing the Card

To begin the flash procedure, do the following:

1. Select the card(s) that you want to flash from the list, then click Select. The

following screen appears:

The meaning of the screen’s fields are explained in the table, below:

Field / Button Meaning

Select card
number:

The RRA automatically assigns a card number to an IP9001 card
that it locates in Recovery Mode. This is helpful when you are
trying to flash more than one card. Think of this dropdown box as
a shortcut to other IP9001 cards that are in Recovery Mode.

MAC Address This field allows you to specify the IP9001 card’s MAC Address.

Note: New settings are automatically stored in the Windows
registry.

Note: When you specify the IP9001 card, it is advisable to set
the MAC address back to the one indicated on the
sticker physically located on the back of the IP9001 card

IP Address This field allows you to specify the IP9001 card’s IP address.

Netmask This field allows you to specify the IP9001 card’s network mask.

Gateway This field allows you to specify the IP9001 card’s gateway or
router address.

Cancel Click to cancel any settings that have not been saved.

OK Click to save the new settings and continue.
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2. Fill in the fields with values that are correct for the card’s IP address and the

network it is on, then click OK.

After a few moments, the Remote Recovery Application dialog box comes up:

3. Click Browse and navigate to the directory that the flash file is locaed in; select it;

then click Open:

Note: Make sure that the image file is NOT Read Only, otherwise you will get

an error message saying that the file cannot be opened in Read/Write mode.
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4. When you return to the Remote Recovery Application dialog box, select the

modules you want to flash (choose one or more sections, or Complete Flash):

5. Click Flash. A confirmation dialog box comes up:
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6. Click Yes to continue. Aprogress indicator screen comes up:

Note: Wait until all the modules have been flashed. Do NOT quit while flashing

is in progress.

When flashing has successfully completed, the following screen appears:

7. Click OK to end the program

Note: If the operation fails, try to flash the image again with Full Image enabled. Do

not flash the Boot Loader.
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Appendix D.

Troubleshooting

Screen Distortion

Problem:

The screen on the host system is blurry when using screen resolutions lower than

1024x768. This happens for both console redirection and the physical terminal on the

host system.

Explanation:

The IP9001 card’s VGA chip has both a digital and analog signal. When the analog

signal is set lower than 1024x768 (for example: 800x600), the IP9001 card’s video

controller uses ratio metric expansion to bring the screen to 1024x768. This causes

the screen to become blurry.

Solution:

Set the screen resolution on the host system to 1024x768.
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BMC Not Responding

Problem:

The BMC does not respond. The host system can’t be powered off, powered on, or

power cycled. Host system health information cannot be obtained.

Explanation:

1. Use server’s onboard BMC to access health information was not enabled in IPMI

configuration.

2. The BMC I2C address isn’t set to 0X20. 0x20 is the correct address for almost all

BMCs. If it is not, the BMC or motherboard provider must supply the correct one.

Solution:

1. Make sure Use server’s onboard BMC to access health information is enabled in

IPMI configuration.

2. Make sure the BMC I2C address is set to 0X20.

Note: Many BMCs feature a reset button that can be used to reset the BMC only.

That button can be used to reset the BMC. If using a BMC without a BMC

reset button, the system must be powered off and the power cable(s)

unplugged. Some BMCs will run on system standby power, and stay on even

though the system is in an off state.
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Connot Manage Host System’s Power Remotely

Problem:

Cannot remotely power on, power off, or power cycle the host system.

Explanation:

1. The feature cable isn’t connected properly between the IP9001 and the host

system’s main board and chassis.

2. The AC wall adapter isn’t connected to the IP9001.

Both of the above connections must be properly made in order for the host system’s

power to be managed remotely.

Solution:

Make sure that the feature cable and AC wall adapter are properly connected
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Unexpected Errors After Flashing New Firmware

Problem 1:

After flashing new firmware to the IP9001, there are unexpected errors.

Explanation:

There was a change in the Config section of the new firmware image and you didn’t

perform a Complete flash. Whenever there is a change in Config section of the new

firmware image, you must perform a Complete flash. Otherwise the default selected

modules are sufficient for flashing.

Solution:

Reflash the firmware, this time doing a Complete flash.

Problem 2:

After flashing, when I log back in, the old firmware version numbers appear in the

screens.

Explanation:

Versions of the older pages are stored in your browser’s cache files, and the browser

is displaying them instead of the new screens.

Solution:

� For IE, on the Tools menu, open Internet Options. On the General page, click
Delete Files to delete the old pages stored in the browser’s cache.

� For Netscape or Firefox (Mozilla), on the Edit or Tools menu, select Preferences
or Options. Select the Privacy button, then click Clear for the Cache item.
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Appendix E.

Modem Daughterboard

Overview

Installation of the optional modem daughterboard allows the IP9001 card to do the

following:

� Configure and reset the IP9001 card

� Update the IP9001 card’s firmware

� View the IP9001 card’s health information and event log

� View the host system’s health information

� Remotely control the host system’s hardware reset and power cn cycle

� Serial over modem text redirection

Note: 1. Host system health information is only available if you have an SDR and

Soft Processor (SP) File for the host system’s motherboard or it has a

Baseboard Management Controller (BMC). The BMC must be IPMI 1.0

compliant or greater.

2. The optional modem is NOT designed for Console Redirection. Although

you can still perform Console Redirection, but it is debilitating and

extremely slow.

3. As of March 15th, 2004, the IP9001 firmware does not support the optional

modem.
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Before You Begin

Avoid Electrostatic Discharge (ESD)

Electrostatic discharge (ESD) can damage the IP9001 card and other

system components. Keep your IP9001 card in its antistatic bag until it is

ready to be installed. Avoid contact with any component or connector on

any adapter card, printed circuit board, or memory module. Handle these

components by the mounting bracket.

Perform all unpacking and installation procedures on a ground connected

antistatic mat. Wear an antistatic wristband grounded at the same point as

the antistatic mat. You can also use a sheet of conductive aluminum foil

grounded through a one megaohm resistor instead of the antistatic mat,

and a strip of conductive aluminum foil wrapped around the wrist and

grounded through a one megaohm resistor instead of a wristband.
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Installation

The IP9001 modem daughterboard is an optional component. Refer to the diagram

below as you perform the following steps:

1. Unpack the modem daughterboard and inspect it for obvious damage.

2. If the IP9001 is already installed in a host system, power down the host system

and IP9001 card. Physically unplug all external and internal cables from the  card.

Remove the IP9001 card from the host system.

3. Locate JP10 on the IP9001 card; align the pins on the modem daughterboard with

the pin holes on the IP9001, then push the daughterboard down until the pins are

completely seated in the pin holes.

4. Plug the IP9001 card into the host system and attach internal cables.

5. Connect external cables. See Chapter 2, Installation, for complete IP9001

installation details.

Nylon Nut Modem Daughterboard

Nylon Screw

2005-06-09

119



Notes:

2005-06-09

120



Appendix F.

Port Usage

Port Usage Table

Port Protocol Purpose Direction

5121 TCP Remote Keyboard and
Mouse data (iUSB HID)

Bidirectional.

5120 TCP CD Redirection
(iUSB - CD)

Bidirectional.

5123 TCP Floppy Redirection
(iUSB - Floppy)

Bidirectional.

7578 TCP Video Redirection Bidirectional.

6577 TCP (&SSL) CURI (API)
(Same is used for SSL)

Bidirectional.

161 UDP SNMP V3 Access Bidirectional.

3072 UDP Trap out port Outgoing from card to
trap destination.

80 HTTP over  TCP Web Server & CLIP Bidirectional.

443 HTTP over  TCP Web Server & CLIP Bidirectional.
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Appendix G.

MAC Address Map

MAC Address Location Description

00-40-D9-0S-9B-3C Server Room 3
Rack 2, 5

Mail Server
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Notes:
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Appendix H.

Linux 7.x Considerations

Overview

This appendix describes how to set up the USB keyboard and mouse for redirection

on a host system running RedHat Linux 7.x. For Linux 8.x and above, disregard this

appendix.

Preparation

Mouseconfig

You will need to install the following file:

mouseconfig-4.22-1.i386.rpm

If it isn’t on the CD that came with your package, you can download it from the

following website:

http://www.redhat.com/support/errata/RHBA-2001-062.html

BIOS Settings

Check your system BIOS to verify that the OnBoard USB and Legacy USB options

are Enabled. If not, the USB devices cannot function.

USB Keyboard

You will be able to redirect the keyboard and use the keyboard on the host system at

the same time. 

Note: LILO is not USB aware. The system BIOS must have USB keyboard support.

If not, you cannot use the redirected keyboard to select a different boot image.
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USB Mouse

� If you are adding USB mouse support to a system that was originally installed with
a PS/2 mouse, follow the instructions, below.

� If you are adding PS/2 mouse support to a system that was originally installed with
a USB mouse, first reboot the computer to allow Linux to configure and reallocate
the interrupts for boththe USB and PS/2 mouse, then follow the instructions, below.

1. To check which X server the system links to, run the following command:

ls -l /etc/X11/X

2. If the X server links to /usr/X11R6/bin/XFree86:

a. Edit the /etc/X11/XF86Config-4 file by adding the following line to the

ServerLayout section:

InputDevice “mouse1" ”SendCoreEvents"

b. Add a new Input Device section below the existing Input Device section:

Section “Input Device”
Identified “Mouse1"
Drive ”mouse"
Option “Protocol” “IMPS/2"
Option ”Device" “/dev/mouse”
Option “ZaxisMapping” “4 5"

EndSection

3. If the X server links to/usr/X11R6/bin/Xwrapper or /usr/X11R6/bin/XF86_SVGA,

edit the /etc/X11/XF86Config file and add a new section, as follows:

Section “Xinput”
SubSection “mouse”

DeviceName “USB mice”
Protocol “imps/2"
XAxisMapping ”4 5"
Port “/dev/input/mice”
AlwaysCore

EndSubSection
EndSection

4. Refresh the X server. After you make and save all the changes to the XF86Config

(orXF86Config-4) file, press [CTRL] [ALT] [BkSp] to restart the X server and

have the new settings take effect. If this does not work, type startx in text mode or

reboot the host system.
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Appendix I.

Specifications

Function Specification

Processor SOC 32 bit 266 MHz
400 MIPS MMU
16K I-Cache
16K D-Cache

CPU Memory 32MB PC-133 MHz SDRAM

Flash 16 MB; 16 bit

Frame Grabber AMI Proprietary Hardware Assist Engine for
Faster Console Redirection
A. Compression Method:

- Hardware + Software Combination
B. VGA Capture Screen Resolution:

- 640 x 480
- 800 x 600
- 1024 x 768

Frame Memory 8MB; 32 bit SDRAM (Standard)
16 MB (Option for OEMs)

VGA Controller ATI RAGE XL; 8 MB 32 bit SDRAM with DVI
output

PCI 2.2 32 bit; 66 MHz

Ethernet LAN 10/100 Mbit SOC Integrated

USB Mouse/KB Controller USB 1.1 Device Controller

USB CDROM Controller USB 2.0 Device Controller

USB Floppy Controller USB 1.1 Device Controller

USB Hub 12C Controller USB 2.0 Hub

Modem + DAA Plug In Socket Modem - 56K

Hardware Monitor PCI Voltages
Card Internal Voltages
Temperature

RTC Time Clock Chip + Lithium Coin Cell

Power Supply PCI 3.3V
PCI 5V
Wall Adapter - 6V; 2.5A
900ma/hr Lion battery
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Function Specification

Serial Ports (x 3) Debug Port
RS-485
1 External

Form Factor Half Size Standard PCI Card

Debut Support Jtag ICE

Power Consumption 15W (max)

Weight 128g

Dimensions 18.77 x 12.67 x 0.21cm
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